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Excel Tutorial 
 
During this introduction you will learn the basics of how to use Excel—how to make a spreadsheet, create a 
graph from that spreadsheet, and interpret the data to answer some basic questions.   
 
Creating a Simple Spreadsheet 

A spreadsheet is a way to organize information so that you can create visualizations or interpret your 
data – it consists of a grid of columns and rows.  A column is vertical, and a row is horizontal.  The 
intersection of a column and a row is called a cell.   Open an Excel spreadsheet and type the headings 
“Year” and “Flow (m3/second)”, as shown below.  In this exercise, we’ll look at data from the Hudson 
River to understand the average flow rate of water moving down the Hudson River at a monitoring 
station at Poughkeepsie, NY.   
 
Now, copy the data below and paste them into rows A and B to fill in the chart. 
 

1989 2647.01 
1990 2029.38 
1991 1021.96 
1992 2304.53 
1993 1242.96 
1994 1348.17 
1995 580.18 
1996 2374.82 
1997 1392.27 
1998 1471.37 

 
 
 

                                   Your data should look like this  
 
 
 
We will put year on the x-axis, because it is the independent variable, and Flow (m³/second) on the y-
axis, because it is the dependent variable.  Remember, a dependent variable is something you are 
measuring, and an independent variable is what you are in control of or what you can manipulate.  In 
this case, we can choose the years we want to measure, but we can’t control the flow.   
  

Making a Graph 
 

You can make many different kinds of charts and graphs, but the most common are the bar, line, and 
scatter plot graphs. To make a graph, you have to highlight the data you want to graph.  Click on cell 
B2, and drag down to cell B11.  Avoid highlighting the headings of your data.   
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After you have highlighted the boxes, click on the “Insert” tab. You can choose what type of Chart you 
would like.  For this first graph, let’s choose a line graph.  
 

  
 
You should get a graph that looks like this:  
 

 
 
Note: if you have a “series 1” legend, you can just click on it and delete it.  You don’t need a legend right 
now since you only have one variable on your graph.   
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To get the years on the x-axis, right click anywhere within the graph box, and then click “Select Data”. 
 

 
 
 A drop box titled “Select Data Source” pops up. 

 
   
 
Click the “Edit” bottom directly under the text 
“Horizontal (Category) Axis Labels”. Then another 
drop box pops up titled “Axis Labels”. This box 
prompts you to provide an “Axis Label Rage”. To 
do this, either type in the cell range of your x-axis 
or highlight the relevant cells (in our case, select 
A2 through A11, and click “OK”). 
 

 
 
 Then click “OK” again to exit the “Select Data 
Source” drop box.  
 
Your graph should look like this: 
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To add a title, x and y axis labels of the graph, click on the graph, and then use the “Layout” tab on the 
top of the screen. To edit the title of the graph click on “Chart Title” and select the “Above Chart” 
option, and type “Hudson River Flow” - the title of your graph.  
 

 
 
To edit the x and y axis labels of the graph, click on “Axis Titles” (right next to “Chart Title”) then click 
on “Primary Horizontal Axis Title” and “Primary Vertical Axis Title” respectively. For the horizontal axis 
choose the option “Below Axis” and type “Year” –the label of the x axis. For the vertical axis choose the 
option “Rotated Title” and type “Water flow (m3/s)” –the label of the y axis.  
 
You should now have a graph that looks like this: 
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Based on this graph, answer the following questions: 
 

1. What year was the flow in the Hudson the highest?  _______the lowest? _______ 
 

2. What are some of the reasons that flow might be higher or lower in different years?   
 
 
 
 

For homework, make a graph of these data: 
 
Sample Chloride (mg/L) 

1 17.34 
2 16.69 
3 15.2 
4 13.94 
5 14.36 
6 15.61 
7 14.96 
8 15.16 

 
Print the graph.  When you are finished, answer the following on the back of your graph: Which 
variable is independent, and which variable is dependent?  Why?    
 
 

Making a Graph: Part 2 
 

Now it’s time to practice using Excel to make a more complicated 
graph, where we will show more information on the Hudson River.  
Looking at ten years of data, you will compare the number of rotifers 
per liter of water with the number of cladocerans per liter of water. 
Later, you will add information about zebra mussels.     
 
Zebra mussels are an invasive mollusk that arrived in the Hudson River 
in the early 1990s.  They are filter feeders and reproduce quickly.   
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Open an Excel spreadsheet and add the data below.   
 

Year 
Rotifers 

#/L 
1989 401.38 
1990 880.12 
1991 1244.15 
1992 505.67 
1993 115.18 
1994 40.00 
1995 60.98 
1996 36.92 
1997 67.71 
1998 8.82 

 
If you have a spreadsheet designed and you forgot to include some important information, you can 
insert a column (or a row) into an existing spreadsheet.  
 

Microscopy-UK.org 

Cladocerans are also microscopic 
crustaceans; they are sometimes 
called water fleas.   
 

A rotifer is a tiny microscopic animal 
that lives just about anywhere that 
there is water, including the Hudson 
River.   
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You have to right click on the column label (letter) and 
choose Insert. This will insert a column immediately left 
of the selected column. Likewise, we can also insert rows. 
With the row label (number) selected you choose Insert. 
This will insert a row above the row you have selected. 
 
Now try inserting a column into the 
spreadsheet you have made!  Insert a 
column between Letters A and B, and add 
the Cladoceran data on the right.   
 
 
 
 

 
 
Your spreadsheet should look like this: 
 

 
 
Now you are ready to create a graph from these data.  Highlight the 
data you want to graph on the y-axis; in this case highlight cells B2 to 
B11 and C2 to C11 at the same time, then click on the “Insert” tab.  
Again, click “Line”.   
 
You should get a graph that looks like this: 
 

 
 
To get the years on the x-axis, follow the same procedure as earlier by clicking on “Select Data”, adding 
the years to the Horizontal Axis Labels, and selecting “OK”. 
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To add labels to the series, go back to the Select Data box.  Then, click on the “Edit” button under 
“Legend Entries”. 
 

 
 
You’ll see a small box pop up that includes a place for 
“Series Name” and “Series Values” (this refers to the 
values that you’ve already selected for the y-axis).  Type 
the name of the series in the “Series Name” box, and 
then select Ok.   
 
 
 

To edit the title, x and y axis labels of the graph, click on the graph, and then use the “Layout” tab on 
the top of the screen. To edit the title of the graph click on “Chart Title” and select the “Above Chart” 
option, and type “Hudson River Biodiversity Changes” - the title of your graph.  
You should now have a graph that looks like this: 
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You should be able to answer the following questions based on this graph: 
 

1. Which animal population changed the most?  _____________________   
2. When did this change occur? ________________________ 

 
3. What could be a reason for the dramatic change in the rotifer population?  

______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________ 
 
 

4. What other kind of information do you need to know in order to decide what caused this 
change?  
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________ 

 
Go on to the next part of the tutorial to learn how to change things about your graph! 

 
 

Changing Your Graphs 
 
Using the same graph from the previous exercise, try working 
with the graph to change some things.   
Let’s try adding a trendline.  This is a line that can show you the 
potential future path of your variable.   
 
Click on one of the data points for the Rotifers on the graph.  
The color and shape of the points will change.  Then right click.  
You will see a small box with some options.  Highlight and then 
click on “Add Trendline…” A box labeled “Trendline Options” 
pops up. Select “Linear” and then click “Close”. 
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Your graph should now look like this: 
 

 
 

Notice that the y-axis values go to -200; this doesn’t make 
any sense, since numbers of animals can’t be a negative, 
only zero.  To correct the scale, right click on any number on 
the y axis, then click “Format Axis” In the “Axis Options” tab 
that pops up, change the “Minimum” from “Auto” to 
“Fixed”. This allows you to change the highlighted value; 
change this value to 0, and click “Close”.  You’ll see that the 
y-axis values changed from -200 to 0.   
 
 
 
Your graph should now look like this: 
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The black line is your trendline.  You can use trendlines to “predict” what might happen in the future, 
or what could have happened in the past.  You can remove the trendline by clicking on the trendline, 
then clicking with the right mouse key, and selecting “Delete”.  You can also get some basic statistics 
about your trendline, such as the equation for the line.  If you are looking at a trend over time, you can 
use the linear regression and find out about whether the R2 value explains the amount of variation in 
your data set.  If your R2   value is very high, that means that most of the points fall along the line (or 
are “explained” by your trendline).   
 
Let’s try another type of change: adding a second Y-axis to your graph.  Doing this allows you to see 
data more clearly, because it can create a scale for one of your variables on the second Y-axis.  This is 
particularly helpful in these types of situations when one group of data (the rotifers) have such a 
different scale from the other (cladocerans).   

 
Do this by right clicking on the data points for “Cladocerans”. Make 
sure that multiple data points are highlighted instead of just one! 
Then, click on “Format Data Series”. 
 
 
 
   
 
 

Click on the “Series Options” tab, click on “Secondary Axis”, and then click “Close”.  
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You should see your graph change dramatically: 
 

 
 

1. Explain why this graph now looks so different: 
 
 
 
 

 
2. Does this change your answer to the earlier question about which animal species showed the 

most dramatic change?  Why or why not?  What else would you need to know before you can 
answer this question?   
 
 
 
 

 
 
Extra credit:  Add a linear regression trendline for both populations – rotifers and cladocerans.  Using 
the equation for each line, explain which population is changing more quickly.   
 
 
 
 
 
 
 
 
 
 

0 
5 
10 
15 
20 
25 
30 
35 
40 
45 

0 

200 

400 

600 

800 

1000 

1200 

1400 

1989 1990 1991 1992 1993 1994 1995 1996 1997 1998 

# 
an

im
al

s/
L 

Year 

Hudson River Biodiversity Changes 

Rotifers 

Cladocerans 

Linear (Rotifers) 



 
 

13 
 

 
 
 
For homework, make a graph of the following data: 
 

Year 
Zebra Mussels Density 
(number/m^2) Rotifers #/L 

1989 0.00 401.38 
1990 0.00 880.12 
1991 7 1244.15 
1992 3929 505.67 
1993 2571 115.18 
1994 1357 40.00 
1995 627 60.98 
1996 346 36.92 
1997 2792 67.71 
1998 865 8.82 

 
Then, answer these questions: 
 

1. In what year did zebra mussels arrive in the Hudson Valley?   
2. What happened to the rotifer population numbers after the arrival of the zebra mussels?   
3. Why do you think this happened?   
4. What other information do you need to know to decide why the rotifer population reacted in 

this way to the zebra mussels?   
5. Add a trendline to your graph.  What do you think will happen in ten years to the rotifer 

population?  To the zebra mussel population?   


